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The List Function

Click this button to get a listing of entries in the currently selected calendar function.



Installation
Need uses the CTL3D.DLL library to give 3D look and feel to its controls.    CTL3D.DLL is a 
Microsoft supplement to Windows which many programs use.    Chances are you already 
have this file in your WINDOWS\SYSTEM directory, however, if you don't, you should copy 
this file to the WINDOWS\SYSTEM directory to get the 3D look for Need.    If you already have
CTL3D.DLL installed, you might want to check to see if the one included with Need is newer 
than the version you already have, if so, make a backup of the version installed, and copy 
the CTL3D.DLL that came with Need to the appropriate directory.

Other than that, Need can be run from anywhere.    Just make sure NEED.HLP file is in the 
same directory as NEED.EXE.

To put Need in Program Manager, first make a program group for Need (FILE/NEW).    Then 
drag NEED.EXE from File Manager and drop it in the newly created group inside of Program 
Manager.    From Program Manager, you can edit the properties of Need (click on the icon, 
then FILE/PROPERTIES) and put the path, and name of your usual data file in the command 
line field.



Future of Need
We are committed to making Need competitive in the shareware Personal Information 
Manager    (PIM) category of software.    We realize that Need V1.0 Beta lacks some key 
features that are essential to any PIM application, therefore we have listed some of the 
features we are planning to add to Need in the near future.    The reason Need V1.0 Beta 
lacks these features is due to time constraints.    We wanted to put out a version of Need now
in order to get user input, and to be in touch with the user's requirements, in order to design
and implement these features in a way that's easy and intuitive.

You may have noticed that some of the menu options are disabled.    This is because the 
code for these features have not been completed, however, Need V1.0 Release will have 
those menu options enabled.

Need V1.0 Planned Enhancements:
- Full support for printing
- Purging capability
- More flexibility (Moving Scheduled Events, To Do tasks, etc.)
- Advanced Search for the Database (Searching by Fields)
- Dialing capability for the Database
- Increased context sensitivity for the help file
- Bug fixes, and/or fine tuning



Registration Information

REGISTERED USERS OF NEED V1.0 (BETA) WILL BE ABLE TO REGISTER NEED 
V1.0 (RELEASE) FOR NO CHARGE,    AND REGISTRATION FOR NEED V1.0 BETA 
IS FREE.

Need is a Shareware program.    An evaluation period of 10 days is granted without requiring 
registration.    After the 10 day period, Need must be registered for further use.    Registration
of Need V1.0 Beta is FREE of charge, however, when Need V1.0 is released, registration will 
NOT be free.    Registered users of Need V1.0 Beta will be able to register Need V1.0 release 
for NO CHARGE!

When registering for Need, please provide:

Name
US Postal address
E-Mail address (if available)
Company Name (if applicable)
How did you get Need? (This could be through friend, BBS, ftp, etc.

If through BBS, also provide BBS name and phone #.
If through ftp site, then please provide ftp site address.
This will allow me to make Need more accessible to users
like yourself.    Thanks!)

Also, include any suggestions and comments you might have.    If you would like to receive 
(via US-Mail) Need V1.0 upon availability, include $3 (US $) to cover disk, and postage costs 
for any location in the US.    Make checks payable to Hamid Shojaee.

Register by sending the above information to:
via E-Mail:

INTERNET: shojaee@enuxsa.eas.asu.edu
CompuServer:75240,63

via "Normal" Mail:
Hamid Shojaee
1833 E. Pebble Beach
Tempe, AZ    85282

As a registered user, you will also be notified of new versions of Need as they become 
available.

Expected release date for Need V1.0 is in December of '93, so register ASAP.    Expected 
registration cost of Need V1.0 is in the range of $15 (US $).



Overview
Need falls under the category of Personal Information Management software.    Need is 
extremely flexible and can be utilized to organize all types of personal information.    The 
present version of Need offers the following in a user friendly package:    a configurable 
information-manager (Database),    a detailed time-manager (Scheduler), a list-manager (To-
Do List), a journal-manager (Journal), and a daily note-manager (Notes).    

Need V1.0 Beta



Notes
Need's Notes feature is designed to provide the user with a daily note-manager.    The Note 
for the currently selected date is located directly beneath the Calendar on Need's Main 
window.    

The Notebook can serve as anything the user chooses...from an electronic Sticky Pad 
or a temporary resting place for ideas.

See Also:
Add a Note
List all Notes
Delete a note
Edit a Note
Purge Notes by Date



Adding a Note
To add a note, single-click the date on the calendar for which the note is intended (if it is not 
already selected);    then, click anywhere on the Note's box to activate it.    Enter your note.

See Also:
Delete a note



Editing a Note
To edit a note, beging by selecting the List option under the Notes Menu.    This will give you 
a complete listing of all Notes.    Then Highlight the note you would like to Edit by single-
clicking it.    Click the Edit button, and this will pop-up the Edit dialog box.    You are now 
ready to edit your note.    Click the OK Button when it is satisfactory.



Listing All Notes
Listing all notes will come in handy when you're looking for a particular note, but you're not 
quite certain which day it was posted on.    To do this, go to the Notes menu and select List.    
This will give you a dialog box with a list of all notes.

See Also:
Edit a Note
Delete a Note



Deleting a Note
To Delete a Note, go to the Notes Menu and select List.    This will give you a listing of all 
Notes.    From there highlight the Note you would like to Delete by single-clicking it.    After 
you have selected the Note, click the Remove button.    

See Also:
Add a Note
Purge Notes by Date



Purging Notes by Date
As of this Beta Version, the Purge feature is yet to be functional.



Journal
Need's Journal Function provides the user with the means to keep track of or to record 
significant    events, progress with projects, or almost whatever else you can think of.    There 
is one thing it is not intended to be:    a detailed diary of events.    

See Also:
Add a Journal Entry
List all Entries
Delete an Entry
Edit an existing Journal Entry
Purge Diaries by Date



Adding a Journal Entry
To add a journal entry, activate the Calendar's Journal function by either clicking on its 
Toolbar icon ( ) or selecting Journal from the Calendar/Select Menu.    After you have done 
this, double-click the date for which you would like to make a Journal entry.    

This brings up the Journal dialog.    The first thing you enter is the Theme of the 
particular journal entry.    The theme will help you organize the entries when they are listed.   
After entering the Theme, type your Journal entry.

See Also:
Delete an Entry

Shortcut

Toolbar:     Then Double click the date for which the entry is to be added.
Keys: ALT+J



Editing a Journal Entry

Editing a Journal entry is done by first activating the Calendar's Journal function (  or from
the Menu:    Calendar/Select/Journal).    Then, select the Toolbar's list icon (

) or the Calendar's Journal/List option from the Menu.    This will give you a listing of all 
Journal entry themes.    Now select the entry you would like to Edit by single-clicking it.    
Then Click the Edit box.



Deleting a Journal Entry

Deleting a Journal entry is done by first activating the Calendar's Journal function ( ).    
Then, select the Toolbar's List icon (

) or the Calendar's Journal/List option.    This will give you a listing of all Journal entry 
themes.    Now, select the entry you would like to Delete by single-clicking it, and clicking the
Remove Button.

See Also:
Add a Journal Entry



Listing All Journal Entries
To List all Journal entries, be sure the Calendar's Journal function is selected from the Toolbar 
( ) or from the Menu:    Calendar/Select/Journal.    Then, simply click the Toolbar's List icon 
(

) or select the Calendar's Journal/List option.    All Journal entries will be displayed by 
date and the Theme of each entry will be shown.

See Also:
Edit an existing Journal Entry

Shortcut

Toolbar:     Then 



Purging Journal Entries by Date
This feature is yet to be added to the present Beta version.



To-Do List
Need's To-Do List functions a list-/project-manager.    Each entry can be categorized under 
user-specified 'projects'.    Of course it works as a shopping list, too...

See Also:
Add an Item
List the To-Do List Items
Delete an Entry
Edit an existing To-Do List
Purge the To-Do List



Adding an Item to the To-Do List (Calendar/To-Do Menu)
To add an item to the To-Do List, activate the Calendar's To-Do List function by either clicking
on its Toolbar icon ( ) or selecting To-Do List from the Calendar/Select Menu.    After you 
have done this, double-click the date for which you would like to add an item to the To-Do 
List.    

This brings up the To-Do List dialog.    The first thing you enter is the Project..    The 
purpose of the Project combo-box is to allow you to organize your lists categorically.    After 
entering the Project, you have the option of assigning a Priority to the item (a Priority of 5 is 
default;    1 is the highest Priority and 9 is the lowest).    You are now ready to enter the item.

See Also:
Delete an Entry

Shortcuts

Toolbar:     Then Double click the date for which the item is to be added.
Keys: ALT+T



Editing the To-Do List Items

Editing a To-Do List item is done by first activating the Calendar's Journal function (  or 
from the Menu:    Calendar/Select/To-Do List).    Then, select the Toolbar's list icon (

) or the Calendar's To-Do/List option from the Menu.    This will give you a listing of all To-
Do List Projects.    Now highlight the entry you would like to Edit by single-clicking it, and 
click the Edit button.



Deleting a To-Do List Item

Deleting a To-Do List item is done by first activating the Calendar's To -Do List function (
).    Then, select the Toolbar's List icon (

) or the Calendar's To-Do/List option.    This will give you a listing of all Journal entry 
themes.    Now, select the item you would like to Delete by single-clicking it, then clicking the
Remove Button



Listing the To-Do List Items

To List    To-Do List Items, be sure the Calendar's To-Do List function is selected (  or from 
the Menu:    Calendar/Select/To-Do List).    Then, simply click the Toolbar's List icon (

) or select the Calendar's To-Do/List option.    All To-Do List Items will be displayed by 
Priority and Project.

Shortcut

Toolbar:     Then 



Purging To-Do List Items
This item is yet to be implemented as of this version.



Scheduler
Need's Scheduler is designed to function as a time-management device.    It allows for 
events to be scheduled with a beginning and ending time, with or without an alarm to serve 
as a reminder.

See Also:
Schedule an Event
Set an Alarm
List Scheduled Events for a Given Date
Delete an Event
Edit an Event
Purge Schedules by Date



Adding an Event to the Scheduler
To Add an event to the Scheduler, first, be sure the Calendar's Scheduler function is 
activated (Do this from the Toolbar's Scheduler Icon:  or from the Calendar's 
Select/Scheduler option from the Menu).    Now double-click the date for which you would like
add an event.    The Scheduler dialog box will appear asking for the information needed.    
After entering the time for which the event is to take place, you have the option of setting 
the alarm.    The alarm will give you a message box with the Brief Description of the event at 
the appropriate [from] time.    Enter the rest of the information and select the OK button.

See Also:
Delete an Event

Shortcuts

Toolbar:     Then double click the date for which the item is to be added.
Keys: ALT+S



Editing a Scheduler Event

Editing a Scheduler event is done by first activating the Calendar's Scheduler function (
 or from the Menu:    Calendar/Select/Scheduler).    Then, select the Toolbar's list icon (

) or the Calendar's Scheduler/List option from the Menu.    This will give you a listing of 
all Scheduler events' brief descriptions.    Now highlight the entry you would like to Edit by 
single-clicking it.    Then Click the Edit box.

See Also:
List Scheduled Events for a Given Date



Deleting an Event From the Scheduler
Deleting a Scheduler event is done by first activating the Calendar's Scheduler function.    
Then, select the Toolbar's list icon or the Calendar's Scheduler/List option.    This will give you
a listing of all Calendar events' brief descriptions.    Now, highlight the event by single 
clicking it, and click the Remove Button.

See Also:
Schedule an Event
Purge Schedules by Date



Listing Scheduled Events
To List all Scheduler events, be sure the Calendar's Scheduler function is selected by simply 
clicking the Toolbar's List icon ( ) or selecting the Calendar's Scheduler/List option.    All 
Scheduler events will be displayed by date and the Brief Description of each event will be 
shown

See Also:
Delete an Event
Edit an Event

Shortcut

Toolbar:       Then double click the date for which the entry is to be added.



Purging Scheduled Events by Date
This feature is yet to be added to the present Beta version.



Database
The Database is initially configured to resemble a phonebook.    It allows for entries to be 
categorized and for detailed information to be given about each entry (two phone numbers, 
address, e-mail address, birthday, as well as comments).    Each heading is configurable 
allowing the user to change its function from a phonebook to virtually anything.

Other Uses

See Also:
Add an Entry
Delete an Entry
Edit an Entry
Configure Headings
Search
Open a Database Saved With Phonebook Manager V0.5



Other Uses:
CD Collection Manager -- categorized by type of music
Library Manager -- categorized by reference, novels, poetry, technical, etc 
Baseball Card Manager -- categorized by year, rookie cards, AL and NL, etc.

The possibilities are truly endless and Need was developed with this flexibility in order to 
provide you, the user, with the power to use it however you choose.



Adding an Entry to the Database
To add an entry to the Database, click the add icon from the tool bar or select the add option
from the Database Menu.    This will bring up the Database dialog.    The first thing you want 
to do is choose the correct category for your entry.    Is it a business number?    Personal?    
Contact?    If the Category does not already exist, you can create one simply by typing it in.    
From here, enter in the rest of the needed information and select the OK button.

Shortcuts

Toolbar:
Keys: CTRL+A



Deleting an Entry from the Database
To Delete an entry from the Database, highlight the entry you would like to delete by single-
clicking it.    Then select the Delete icon from the Toolbar or the Delete option under the 
Database Menu.    This will immediately delete the item.

Shortcuts

Toolbar:
Keys: CTRL+D



Editing an Entry on the Database
To edit a Database entry, first select the entry you would like to edit by single-clicking it.    
Then click the Edit icon on the Toolbar or select the Edit option under the Database Menu.    
This will bring up the Database dialog and you can edit any item you like.    Select OK when 
all is satisfactory.

Shortcuts

Toolbar:
Keys: CTRL+E



Searching the Database
There are two kinds of search operations that may be done on the Database:

Simple Search:
This search can easily be done by clicking on the search edit box, and typing the 

entry you are looking for.    As you are typing, the closest match to what you have typed will 
be selected in the list box.

Advanced Search:
This feature has not been implemented at this time.

Shortcuts for Advanced Search

Toolbar:
Keys: CTRL+F



Configuring Headings for the Database
The Database is initially set up to operate as a complete Phone-/Address-Manager with fields
for Name;    Phone Number;    Address;    Etc.    These Fields, however, can all be changed 
changing the Database from basically a phonebook to virtually anything you would like.    

To change the Headings Click the Toolbar's Configure Icon or select Configure under 
the Database Menu.    This will pop-up the Configure dialog box.    Change the Headings you 
would like to change and Click the OK button when you are done.

The dialog that appears should look like the following:

Shortcuts

Toolbar:



Configurability:

For example, the heading 'Name' could be changed to 'Product Name'; the heading 'B-day' 
could be changed to 'Price'; 'Phone (Home)' could be changed to 'Quantity in Stock'; etc.    
This would change the database from a phone book to a product manager within seconds.    

NOTE:    The First Two Fields Are Displayed From Needs Main Screen, So Label Them 
Accordingly.



Categories:
Need's Category field allows you to better organize your Database.    Remember, the 
database can be used to store any information, not just phone numbers, addresses, and so 
on.    Below are some sample categories for a Phone Book Database.

Business
Personal
Contacts
Etc.



Opening a Phonebook Manager V0.5 Database
This feature was included for all Phonebook Mangager V0.5 users.    By selecting Open PM 
V0.5 under the file Menu, you can convert your old database to Need format.



File menu commands
The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Open PM V0.5 Opens an existing document made with Phonebook Manager V0.5
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits Need.



Database menu commands
The File menu offers the following commands:

Add Adds an entry to the Database.
Delete Deletes the highlighted Database entry.
Edit Edits the highlighted Database Entry.
Find PlaceS cursor in search box...type in entry to search.
Configure Opens dialog allowing heading to be changed.



Calendar menu commands
The Calendar menu offers the following commands:

To-Do 

Add Adds an Item to the To-Do List.
List Lists all To-Do List Items.

Scheduler

Add Adds an Item to the Scheduler.
List Lists all Scheduler Entries.

Journal

Add Adds an event to the Journal.
List Lists all Journal Entries.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Notes menu command
The Notes menu offers the following command:

List Lists all Notes.



Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)
Use this command to create a new document in Need.

You can open an existing document with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)
Use this command to open an existing document in a new window.    You can open multiple 
documents at once.    Use the Window menu to switch among the multiple open documents.  
See Window 1, 2, ... command.

You can create new documents with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Need Document
Drives

Select the drive in which Need stores the file that you want to open. 
Directories

Select the directory in which Need stores the file that you want to open.
Network...

Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)
Use this command to close all windows containing the active document.    Need suggests 
that you save changes to your document before you close it.    If you close a document 
without saving, you lose all changes made since the last time you saved it.    Before closing 
an untitled document, Need displays the Save As dialog box and suggests that you name 
and save the document.

You can also close a document by using the Close icon on the document's window, as shown 
below:



Save command (File menu)
Use this command to save the active document to its current name and directory.    When 
you save a document for the first time, Need displays the Save As dialog box so you can 
name your document.    If you want to change the name and directory of an existing 
document before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)
Use this command to save and name the active document.    Need displays the Save As 
dialog box so you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a document with a different name.    A filename can contain 
up to eight characters and an extension of up to three characters.    Need adds the 
extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want 
to open.



Exit command (File menu)
Use this command to end your Need session.    You can also use the Close command on the 
application Control menu.    Need prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Need, such as File Open.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Need,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new document.

Open an existing document.    Need displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active document or template with its current name.    If you have not named
the document, Need displays the Save As dialog box.

Add an entry to the Database.

Delete an entry from the Database.

Edit a Database Entry.

Search for a Database Entry by Name (Field 1).

Configure the Database Fields.

Activates the Calendar's To-Do List Function.

Activates the Calendar's Scheduler Function.

Activates the Calendar's Journal Function.

Print the active document. (Not implemented in Beta version!)



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Need window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Need and various types of reference information.  

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of Need.



Context Help command 

Use the Context Help command to obtain help on some portion of Need.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question 
mark.    Then click somewhere in the Need window, such as another Toolbar button.    The 
Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars
Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the Need window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Next Window command (document Control menu)
Use this command to switch to the next open document window.    Need determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)
Use this command to switch to the previous open document window.    Need determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box
<< Write application-specific help here. >>



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>









Print command (File menu)
NOT IMPLEMENTED IN NEED V1.0 BETA

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog
The Printing dialog box is shown during the time that Need is sending output to the printer.    
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)
NOT IMPLEMENTED IN NEED V1.0 BETA

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar
The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)
<< Write application-specific help here. >>




